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ICONICS LICENSE AGREEMENT 
YOU SHOULD CAREFULLY READ THE FOLLOWING  

TERMS AND CONDITIONS! 
 
Opening and using the enclosed software for any purpose indicates your 
acceptance of the terms and conditions of this license agreement.  If you do not 
agree with them, you should return all software, documentation and copy 
protection keys within seven days of shipment unopened and your money will be 
refunded. 
 
ICONICS provides this program and licenses its use in the United States, Puerto 
Rico, or internationally.  You assume the responsibility for the selection of the 
program to achieve your intended results, and for the installation, use and results 
obtained from this program. 
 

LICENSE 
You are granted a personal license to use this program under the terms stated in 
this Agreement.  You may: 1) Install and use the program on a single machine; 
and 2) make a single archival back-up copy of the program for the sole purpose of 
supporting your use of the single program on a single machine.   You may not 
copy, translate, modify or adapt the program, or any portion thereof, or incorporate 
it, in whole or any part, in any other product, create derivative works based on the 
program, or any portion thereof, or license others to reproduce any copies of the 
program, or any portion thereof, and you may not decompile, disassemble or 
reverse engineer the program, or any component thereof except as permitted by 
law, and then only after having prior requested in writing from ICONICS any 
interoperability information you are attempting to obtain. 
 

TERM 
The license is effective until terminated.  It will terminate if you fail to comply with 
any term or condition of this Agreement.  You agree, upon such termination, to 
destroy the program and all copies that were made from it and to promptly return 
any copy protection key(s) to ICONICS. 
 

LIMITED WARRANTY 
ICONICS WARRANTS THE CD-ROM, DVD OR PHYSICAL DISKETTES, ON 
WHICH THE PROGRAM IS FURNISHED, AND PHYSICAL DOCUMENTATION 
TO BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP UNDER 
NORMAL USE FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE OF 
DELIVERY TO YOU AS EVIDENCED BY YOUR RECEIPT.  THIS PROGRAM IS 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD 
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. 
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ICONICS SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED 
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.  IN PARTICULAR, WITH RESPECT 
TO ANY PARTICULAR APPLICATION, USE OR PURPOSE, IN NO EVENT 
SHALL ICONICS INC. BE LIABLE FOR ANY OTHER COMMERCIAL DAMAGE, 
INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL 
OR OTHER DAMAGES.  ICONICS DOES NOT WARRANT THAT THE 
FUNCTIONS CONTAINED IN THE PROGRAM WILL MEET YOUR 
REQUIREMENTS OR THAT THE OPERATION OF THE PROGRAM WILL BE 
UNINTERRUPTED OR ERROR FREE. 
 

LIMITATION OF REMEDIES 
ICONICS’ entire liability and your exclusive remedy shall be the replacement of any CD-
ROM, DVD or diskette not meeting ICONICS’ “Limited Warranty” which is returned to 
ICONICS with a copy of your receipt within the warranty period.  The remedy for breach 
of this warranty shall be limited to replacement and shall not encompass any other 
damages including but not limited to loss of profit, special, incidental, consequential, or 
other similar claims arising out of the use or inability to use such program even if 
ICONICS has been advised of the possibility of such damages, or for any claim by any 
other third party. 
 

GENERAL 
This Agreement will be governed by the laws of the Commonwealth of Massachusetts.  
Should you have any questions concerning this Agreement, you may contact ICONICS 
in writing at: 
 

ICONICS, Inc. 
100 Foxborough Boulevard 

Foxborough, MA 02035 
 
You acknowledge that you have read this Agreement, understand it and agree to be 
bound by its terms and conditions.  You further agree that it is the complete and exclusive 
statement of the Agreement between you and ICONICS which supersedes any proposal 
or prior Agreement, oral or written, and any other communications between you and 
ICONICS relating to the subject matter of the Agreement. 
 

ICONICS RETURN POLICY 
All sales are final (NO RETURNS) unless one of the following conditions is applicable:  
Program is returned in its original packaging material within 7 days after shipment.  In 
such a case, a full refund is provided, less all incurred shipping and handling costs.  
Program is returned within 30 days from the original shipment date.  In such a case a 
20% restocking fee is applicable.  No returns are allowed on OPC ToolWorX or ActiveX 
ToolWorX.  All returns must have an appropriate RMA number. 
 

EXPORT COMPLIANCE 
You agree to comply with the United States of America’s current Export Administration 
Regulations (EAR) and agree that you will not distribute or supply this product in violation 
of the EAR.  You are responsible for securing any export approval or license as may be 
needed under the EAR.  Additionally, you are responsible for obtaining local customs 
clearance as applicable and paying all duties, taxes and other charges. 
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1 ANALYTIX OVERVIEW 
1.1 Introduction 

Welcome to ICONICS AnalytiX®, a new generation of 
Manufacturing Intelligence software designed to help you 
increase profitability, reduce energy and maintenance costs, 
control operating costs, and react to emergent situations 
before they negatively impact your bottom line. 
 
AnalytiX empowers decision makers at all levels of the 
enterprise with real-time information to help them drive 
global operational efficiency and strengthen competitive 
market advantage. ICONICS AnalytiX solutions leverage the 
latest Microsoft technologies including the Windows Server 
platform, SQL Server, and SharePoint for rich, IT-friendly 
visualization components. 
 
ICONICS AnalytiX is comprised of the following products: 
 

• AnalytiX Suite* 
• Facility AnalytiX® 
• CFSWorX™ 
• BI Server 
• BridgeWorX64™ 
• ReportWorX64™ 

 
* The AnalytiX Suite installation is comprised of the following 
options: 

o Platform Services – Core connectivity and 
communications layer shared between products 
o Facility AnalytiX – Predictive Software for 

Facilities Management 
o Help – Product Documentation 

 
ICONICS AnalytiX Installation also includes the Workbench 
multi-functional, centralized web-based environment. 
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This Getting Started manual explains how you can: 
• Install the AnalytiX software. 
• Familiarize yourself with and start using the 

Workbench 
• Access online help and technical support. 

Note: This manual is an abbreviated version of the full 
AnalytiX Help documentation, which is available in the 
AnalytiX product installation.
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2 SYSTEM REQUIREMENTS 
AnalytiX has the following minimum system requirements. 
Your system must meet the minimum requirement before 
you can install AnalytiX. 
 
Before installing any products please make sure you have 
the correct prerequisites installed.  
 
ICONICS Suite 
 
ICONICS advanced visualization, productivity, and 
sustainability solutions are built on its flagship products: 
GENESIS64™ HMI/SCADA, Hyper Historian™ plant 
historian, AnalytiX® solution suite and MobileHMI™ mobile 
apps. ICONICS is leading the way in cloud-based solutions 
with IoTWorX™, which helps customers embrace the 
Internet of Things (IoT) and Industry 4.0. This end-to-end 
software solution provides remote cloud monitoring and 
analytics via low-cost IoT gateway devices. Delivering 
information anytime, anywhere, ICONICS solutions scale 
from the smallest standalone embedded projects to the 
largest enterprise applications.  
 
ICONICS System Requirements vary between: 

• Minimum Requirements 
• Medium-powered Requirements 
• High-powered Requirements 
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System Requirements - Minimum Requirements 
 

CPU 
Dual Core 64-bit processors (e.g., AMD Athlon 64 X2, Intel 
Xeon, and AMD Phenom) 
 
Memory 
4 GB of RAM is required (6 GB Recommended)   
Note: It is recommended that the system page file size be a 
minimum of four (4) times the size of installed (physical) 
RAM. 
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) on the 
system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Drive 
DVD Drive for Installation 
 
Video Card 
Onboard Video Memory (256MB) Display resolution 
minimum - 1024x768, 32-bit color 
DirectX 9 or 10 Video Card or better 
 
Operating System 

• Windows 10 x64 (Pro or Enterprise Edition)  
• Windows 8.1 x64 (Pro or Enterprise Edition) 
• Windows 7 SP1 x64 (Professional or Enterprise 

Edition)  
• Windows Server 2019  
• Windows Server 2016 x64  
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• Windows Server 2012 R2 x64  
• Windows Server 2012 x64   

Note: Windows 10 Anniversary Update is required for 
MobileHMI UWP app.  
Note: Server-class operating system highly recommended 
for web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Internet Explorer,Firefox, Safari, or Chrome 
 
SQL Server 

• Microsoft SQL Server 2019 
• Microsoft SQL Server 2017  
• Microsoft SQL Server 2016  
• Microsoft SQL Server 2014  
• Microsoft SQL Server 2012 R2  

 
Notes:  

• The connection to SQL Server data source may 
be either local or remote. 

• ICONICS supports SQL databases with 
encryption. 
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System Requirements - Medium-powered Requirements 
 
CPU 
Quad Core 64-bit processors or better (e.g., AMD Athlon 64 
X2, Intel Xeon, and AMD Phenom) 
 
Memory 
8 GB of RAM or higher   
Note: It is recommended that the system page file size be 
a minimum of four (4) times the size of installed (physical) 
RAM.  
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) on the 
system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Drive 
DVD Drive for Installation 
 
Video Card 
Onboard Video Memory (500MB) Display resolution 
minimum - 1024x768, 32-bit color 
DirectX 9 or 10 Video Card or better 
 
Operating System 

• Windows 10 x64 (Pro or Enterprise Edition)  
• Windows 8.1 x64 (Pro or Enterprise Edition) 
• Windows 8 x64 (Pro or Enterprise Edition)  
• Windows 7 SP1 x64 (Professional or Enterprise 

Edition)  
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• Windows Server 2019  
• Windows Server 2016 x64  
• Windows Server 2012 R2 x64  
• Windows Server 2012 x64   

Note: Windows 10 Anniversary Update is required for 
MobileHMI UWPapp.  
Note: Server class operating system highly recommended 
for web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Internet Explorer, Firefox, Safari, or Chrome 
 
SQL Server 

• Microsoft SQL Server 2017  
• Microsoft SQL Server 2016  
• Microsoft SQL Server 2014  
• Microsoft SQL Server 2012 R2  
• Microsoft SQL Server 2008 R2 SP1   

 
Notes:  

• The connection to SQL Server data source may 
be either local or remote. 

• ICONICS supports SQL databases with 
encryption. 
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System Requirements - High Powered Requirements 
 
CPU 
Quad Core 64-bit processors or better (e.g., AMD Athlon 64 
X2, Intel Xeon, and AMD Phenom) 
 
Memory 
16 GB of RAM or higher   
Note: It is recommended that the system page file size be 
a minimum of four (4) times the size of installed (physical) 
RAM.  
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) 
on the system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Drive 
DVD Drive for Installation 
 
Video Card 
Onboard Video Memory (1GB) Display resolution minimum - 
1920x1080, 32-bit color  
DirectX 9 or 10 Video Card or better 
 
Operating System 
Windows 10 x64 (Pro or Enterprise Edition)  
Windows 8.1 x64 (Pro or Enterprise Edition) 
Windows 8 x64 (Pro or Enterprise Edition)  
Windows 7 SP1 x64 (Professional or Enterprise Edition)  
Windows Server 2019  
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Windows Server 2016 x64  
Windows Server 2012 R2 x64  
Windows Server 2012 x64   
Note: Windows 10 Anniversary Update is required for 
MobileHMI UWP app.  
Note: Server class operating system highly recommended 
for web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Internet Explorer, Firefox, Safari, or Chrome 
 
SQL Server 
Microsoft SQL Server 2017  
Microsoft SQL Server 2016  
Microsoft SQL Server 2014  
Microsoft SQL Server 2012 R2  
Microsoft SQL Server 2008 R2 SP1   
 
Notes:  

1. The connection to SQL Server data source may 
be either local or remote. 

2. ICONICS supports SQL databases with 
encryption. 
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NOTE: The requirements described above are based on 
typical applications. Depending 
on your specific application, the minimum requirements may 
vary.  
 
Optional Hardware 

• Ethernet adapter, WiFi card, or cellular 3G/4G 
• USB port (for hardware license) 
• Serial COM ports or other adapters (for data I/O) 

 
Uninstalling 
It is recommended by ICONICS to use Add/Remove 
Applications from Control Panel to uninstall the applications. 
Since applications are registered in the registry, 
Add/Remove uninstalls the product and makes the required 
registry changes for you. 
 
If you uninstall some common components that are used by 
the product, you may be required to register those 
components again or simply reinstall the product. 
 
NOTE: Do not delete the files and directories manually; 
doing so will leave the registry entries intact and interfere 
with future installations. Please use the uninstall feature of 
the operating system!
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NOTE:  The requirements described above are based on 
typical applications. Depending on your specific application, 
the minimum requirements may vary. The system 
requirements above assume that the OPC server(s) are 
installed locally on the system and the ICONICS 
components are all installed and running. For AnalytiX 
application servers that will also utilize portions of the 
ICONICS GENESIS64 HMI/SCADA suite, including tools 
within the Platform Services, note that those requirements 
are separate and must also be taken into consideration.  
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3 INSTALLING ANALYTIX 
IMPORTANT NOTE: It is recommended that users 
uninstall ANY previous versions of ICONICS software 
before installing the latest version. 
The following steps detail the AnalytiX system installation. 
The AnalytiX installation uses standard InstallShield software 
to provide you with options for inputting components. This 
includes adding new or existing users, configuring the 
database engine that allows you to use and edit the size of 
the tables that are created, and more. 
Warning: Prior to installation, verify that the system meets 
minimum hardware and software requirements, as described 
in the System Requirements section. The installation aborts 
if the minimum requirements are not met. 
Note: You cannot install any 10.9x product from Remote 
Desktop when using a shared drive. If you are using a 
shared drive, it is suggested that you copy the installation's 
sources to a local drive or share the drive via Windows 
networking rather than via Remote Desktop. 

3.1 Starting the Installation Process 
To Install AnalytiX: 
1. Insert the installation DVD into your optical drive. The 

installation begins automatically if autostart is operating 
correctly. If not, open the DVD drive window and 
double-click the Default.hta file icon.  
The main installation screen appears, as shown below.  

2. Select “ICONICS Suite” under “Product Installation”. 
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3. You may be asked to install some prerequisite 
components at this time, as in the example shown 
below. Click on the “Install” button to proceed. 

 
4. In the Welcome dialog box shown below, click the Next 

button to view the License Agreement step. 

 
5. Click the “I accept the terms of the license 

agreement” radio button.  
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6. Click the Next button to continue.  
 
 
 
 
 
 
 
 
 
 
 

7. In the Setup Type screen that appears, select the type 
of setup you wish to perform. The options are either 
Complete or Custom. Complete installation installs 
most of the components of AnalytiX and can, as an 
option, overwrite the supporting SQL database files or 
include sample displays via GenDemo. 

 
8. The following window allows you to decide whether to 

include the additional Facility AnalytiX Equipment 
Library (with preconfigured rules for popular Building 
Automation Equipment) to your installation.  
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Customers who have purchased Facility AnalytiX can 
contact ICONICS for the Serial Number to enter here to 
activate this feature.  

 
9. Once the code has been entered (or to proceed with 

the normal installation), click Next.  
10. In the Login Information window, enter your User 

Name and Password.  
You can also click on the New User Information button 
to specify info about a new user that is created during 
installation.  

11. Click Next to continue. The Database Server window 
appears. 
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12. Use the pull-down menu or click the Browse button to 
navigate to your selected database server.  
Once you have selected a database server, you can 
customize your database creation and choose to utilize 
either Windows authentication or SQL Server 
authentication (using the Login ID and password token).  

 
13. Click Next to continue. 
14. The next window provides you with the option to go Back 

and change any previous installation settings.  
Click on the Install button if you do not need to make 
changes. The Database and Services Setup window 
appears. 
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15. From here, you can decide if you want to include 
sample data with the installation, as well as if you would 
like to overwrite existing databases.  
Clicking the ellipsis button [...] to the right of each 
individual database allows you to set Database File and 
Log File settings for each database. This includes: 
Initial Size (in MB), File Growth (in either percentage or 
MB) and Maximum File Size (either Restricted [in MB] 
or Unrestricted).  Make your selections, then click 
Install to proceed. The InstallShield Wizard Complete 
window appears. 

 
16. Click Yes, I want to restart my computer now to 

restart your computer. 

 



AnalytiX Getting Started Installing AnalytiX 

ICONICS 3-7 

3.2 Installing Individual Components 
1. Insert the installation DVD into your optical drive.  

The installer begins automatically if autostart is 
operating correctly. If not, open the DVD drive window 
and double-click the Default.hta file icon.  
The main installation screen appears, as shown below. 
You can now select your desired individual component 
for installation and the procedure is similar to section 
3.1 “Starting the Install”. 

3.3 Uninstalling AnalytiX 
It is recommended that you back up all of your project-
related files before uninstalling. If your operating system 
requires a login, you must log in with administrator privileges 
to uninstall. Uninstalling AnalytiX software (or its 
components) does not uninstall the Licensing software. Your 
valid license will remain activated on your PC. 
Uninstalling AnalytiX:  

1. From the Windows Start menu, select Settings. 
2. From Settings, select the Control Panel.  
3. Double-click Add/Remove Programs. From the 

list of programs that you can remove, select 
ICONICS AnalytiX (or ICONICS MobileHMI, etc.). 

4. Click Change/Remove to remove AnalytiX and all 
of its components.  

5. Select Remove, and click the Next button.  
When the files are removed, the uninstall program 
indicates that the process is complete.  
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4 ICONICS SOFTWARE LICENSING 
4.1 Software and Hardware Keys 

AnalytiX licensing is handled by a software key license 
registration system that does not require a hardware 
protection key. However, ICONICS does offer an optional 
hardware key which you can purchase.  

4.1.1 Software Licensing 
The software key is a licensing key that resides on the hard 
drive of a computer. Each software key is used on a single, 
specific computer and is used only once. It is activated using 
a Site Key (license file) that is tied to the computer that is 
being licensed.  
An activated license is required to use the software in full 
production mode. This license designates which products 
may be used, as well as the I/O point-count limit that controls 
the number of active data points (tags) that can be used by a 
system. 
For important details about registering and activating 
software licenses for your AnalytiX installations, refer to the 
ICONICS .NET Licensing Readme.htm file, which is 
available on your AnalytiX installation DVD (and as a link 
from the disc’s Info Center). 

4.1.2 Hardware Key 
The optional hardware key is a USB thumb drive (or flash 
drive) that you can move from system to system. AnalytiX 
recognizes the hardware key on the system you have the 
key attached to. A hardware key is easier and is a more 
reliable way of moving a license from one machine to 
another than a software key. 
Upon insertion of the USB key into an available USB port, 
the necessary drivers are automatically loaded.  
A green status light will illuminate upon successful 
connection. Should the USB key be missing or unplugged 
during operation of AnalytiX software, plug the USB key 
back in either within an hour of removal or upon system 
reboot; otherwise the hardware-based license will not be 
immediately recognized. 
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Should you require a replacement key, visit 
http://www.iconics.com/supportworx. New users must create 
an account through the ICONICS Web Licensing Utility in 
order to request replacement keys. 

4.2 Licensing Utility 
The Software Licensing Utility provides full authorization for 
use to any purchased AnalytiX product and its available 
options.  

4.2.1 Running the Licensing Utility 
To launch the License Utility from the Windows Start menu, 
select Programs > ICONICS .NET Licensing > Licensing 
Utility. 

 
4.2.2 License File 
 

Once you have opened the Software Licensing Utility, you 
can browse for the Site Key (License File) itself. Either click 
on the Browse… button in the License File section of the 
window OR click on File in the top menu, then Select 
License File…. 
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This brings up the Windows Explorer so that you may 
browse for the License File itself. Once you have located the 
file, double-click it or click Open to proceed. 
 

4.2.3 Activating the 30-day Trial/Emergency License 
 
Within the Licensing Utility (Software License Activation for 
.NET) dialog box, you can click on the Activate Trial 
License box to initiate a 30-day trial/emergency license.  
NOTE: This license can be activated only once per 
machine. 
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You will then see a warning about proceeding with activating 
the 30-day trial/emergency license. Click Yes, should you 
wish to proceed. 

 
You will then see an additional warning confirming that you 
understand that enabling the trial license will invalidate any 
other software license that is currently active on the 
machine. Click Yes should you wish to proceed. 
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Once the 30-day trial/emergency license has been enabled, 
you will see the following messages: 

 

 
 

The PC will then be authorized to run for a one-time only, 
30-day backup period. The PC can be fully authorized at any 
time during or at the conclusion of this temporary backup 
period. Clicking No in the initial windows returns you to the 
Licensing Utility (Software License Activation for .NET) 
dialog box and preserves the existing license. 
 
Note: Temporary backup license authorization is intended 
for urgent backup situations only. Clicking OK invalidates the 
existing license and activates a temporary backup 
authorization, permanently overwriting any existing license. 
Thus, please use caution when activating a temporary 
backup license authorization. 

4.2.4 Killing a Software Key License 
 

Killing a software key license deletes it and removes the 
current software license from the machine. 
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To Kill or Delete the Existing Software License:  
1. Select Kill Current License within the Licensing Utility 

(Software License Activation for .NET) dialog box. Using 
this option, you can remove the current software license 
from the current machine. 

 
 
A warning message appears on the screen as shown in the 
figure below.  
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IMPORTANT: If you kill your license, you need to get a new 
license from ICONICS to restart your AnalytiX product. 
 
2. Click Yes to continue, or click No to exit. Clicking Yes 

displays one of the following warning messages.  
If you are killing a trial or emergency license, once you 
click Yes you are done.  
Note:  A trial or emergency license cannot be credited 
back to the web-based License Generator using the Kill 
Code.   
If you are killing a permanent, registered license, after 
you click Yes, the following warning message appears. 
Notice that the message lists the old Site Key, and a Kill 
Code. It also lists a .TXT file that has been written to 
the PC's desktop; the file name begins with "KillCode". 
This file contains the old Site Key and Kill Code that are 
listed in the message.  
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3. Click Yes to copy the Kill Code to the Windows 
Clipboard so that you can paste it elsewhere, 
such as in an email to ICONICS Support or on 
the ICONICS Web Licensing Utility. If you don't 
need to copy the Kill Code at this time, click No.  

4. Look on the desktop for the KillCode*.TXT file. 
Keep this file, and copy it to a safe location! 
You will have to use the information it contains to 
confirm that you have killed your license (via 
either the ICONICS Order Entry Department or 
the ICONICS Web Licensing Utility). 

5. Proceed with the online steps described in 
4.4.3.1 “Killing a License via the ICONICS Web 
Licensing Utility” 

Note: To reinstate a permanent license that you killed, 
you will need to provide the KillCode*.TXT file to 
ICONICS.  
Note:  If you uninstall the Software License Utility, the 
KillCode*.TXT file will be deleted. For this reason, 
make sure you copy the KillCode*.TXT file to a safe 
location or be sure to note or print its content before 
uninstalling the Software License Utility on the PC.   [* 
= Site Key that was killed.] 

4.3 License Viewer 
When you purchase licenses, the licenses are measured in a 
point count that determines the number of OPC tags that you 
can use in your application. One point count is used for most 
AnalytiX applications. There are two different modes for 
using tags in point counts: 
• On-demand mode. A system for dynamically using licensed 

points, and then reusing the points as needed. The count 
at any instance includes only active points in use.  

• Configure mode. A system in which all points are 
statically configured in a static central location, inside 
the Unified Data Manager. All configured points are 
counted against the point count.  
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The two mode types are not interchangeable and require 
you to buy a new license to upgrade your existing license 
status. 
At any time, you can use the License Viewer to review the 
license status of ICONICS products installed on that 
computer. You can access the License Viewer by: 
• From the Windows desktop: click Start > All Programs 

> ICONICS Licensing > ICONICS .NET Licensing > 
MonitorWorX Viewer. 

• From the Workbench: from the Tools ribbon click the 
Licensing button. Or from the File menu, select Tools, 
and then Licensing. The License Viewer displays as 
shown in the following image. 

 
The tab that displays initially is the Overview tab, where you 
can see general information about the license for the server 
that the node points to. You can view license information for 
GENESIS64, AnalytiX, Data Connectors, BizViz products 
(under the AnalytiX tab), and AlarmWorX Multimedia 
product features by using the tabs for those products. To 
locate the nodes where individual product features are 
consuming the server's license counts, use the Diagnostics 
tab. 
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4.4 Web Licensing 
You can use the ICONICS Web Licensing Utility to generate 
a new license, kill a license and transfer a license. One 
function of the ICONICS Web Licensing Utility is to use it to 
upgrade your license. 
 
Supported operating systems for using the ICONICS Web 
Licensing Utility to upgrade your license include Windows 8 
x64 (Professional or Enterprise Edition), Windows 7 x64 
(Professional, Ultimate, or Enterprise Edition), Windows 
Server 2008 R2 x64, Windows Vista x64 SP2 (Business, 
Ultimate, or Enterprise Edition), Windows Server 2008 x64 
or Windows Server 2003 x64. Using the utility will require 
Internet access and a web browser (e.g. Internet Explorer 
6.0 and up). 
 

4.4.1 Acquiring a New Software License 
Users of ICONICS software can use the ICONICS Web 
Licensing Utility to acquire a new software key license.  

4.4.1.1 Issuing a New Software License 
 

1. On the machine where you want the AnalytiX 
license to reside, open the License Utility by going 
to Start -> Programs -> ICONICS Licensing -> 
ICONICS .NET Licensing -> Licensing Utility. 
This should open the Software License Activation 
for .NET window. 

 
2. You will see a dialog come up with a Site Code 

and “No Current Site Key” within the Site Key text 
box. Leave this window open. 
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3. Go to http://www.iconics.com/supportworx and 
launch the Web Licensing Utility Site by clicking on 
the “License Product” link on the right side of the 
page.  

 

 
 
Or, from ICONICS website 
(http://www.iconics.com), select “License Your 
Product” from the bottom-right Customer 
Connection area. 

http://www.iconics.com/supportworx
http://www.iconics.com/
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4. The main page of the Web Licensing Utility will 
load. Click on the “Software” button to access the 
Software License Options. 

 

 
5. You will be required to log in to access the 

Software License Options. Enter your email 
address and password and click on the “LOGIN” 
button. If you do not yet have an account, you can 
create one by clicking on the “Create New 
Account” link near the bottom of the page. 

 

 
 
 

6. Once you have logged into the website, click on 
the “New License” link in the top navigation bar. 
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7. Enter your Product Registration Numbers and 
Customer Keys for the products to license, then 
click “Next”. 

 
NOTE: Your Product Registration Number and 
Customer Key are usually inside the DVD package 
that ICONICS sent to you. 
 

 
8. In the next screen, you will be requested to identify 

the end user for whom the license is being issued. 
You can look up a list of users that have been 
previously entered by clicking on the “Existing End 
Users” link or can enter a new one by clicking on 
the “Create New” link. 

 

 
 

9. Clicking the Existing End Users link will open a 
new window with a list of previously entered end 
users (either entered by you or tied to the product 
registration numbers entered in the previous 
screen). Select an end user from the list and click 
“Select” or double-click the selected end user.  

 
 

If you, yourself, are the end user and you are not 
listed in the grid, you can click on the “I am the 
End User” link to enter your data as the new end 
user. After identifying the end user, click on “Next”. 
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10. In the next screen, you will see a list of the 
products that are available for you to license. 
Check all the products that you would like to 
license. Copy the Site Code from the license utility 
of the destination machine and paste it into the 
Site Code box of the current web page, then click 
on “Next”. 
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11. Review the license information before proceeding. 
Click on “Generate Key” to issue the new Site Key. 

 

 
 

12. The next page will show you a summary of what 
will be your license, as well as your Site Key and 
License File. 

 

 
 

13. Download the license file (*.glic) by clicking on the 
link. You will need this file to license the machine. 
NOTE: If you misplace the file after receiving it, 
you can use the View License link with your 
Product Registration Number to download it again. 

14. In the Software License Activation Utility, click on 
the “Browse” button and look for the license file 
that you downloaded from ICONICS website. 

15. Once you have selected the file and the License 
File textbox shows the file path, click on the 
“Activate License” button. 
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16. You should then receive a popup message 
indicating the status of the license activation. You 
can click on “OK” to close the dialog. 

17. The Software License Activation Utility should now 
show the current license information, similar to the 
following image. 

 

 
 

18. Notice that the Site Code may change, as 
expected, but the Site Key should be the same 
one you saw on the website. 
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4.4.2 Adding to an Existing Software License 
 

1. Go to http://www.iconics.com/supportworx and 
launch the Web Licensing Utility Site by clicking on 
the “License Product” link on the right side of the 
page.  

2. Once you have logged into the website and 
accessed the Software License main page, click on 
the “Add to License” link in the top navigation bar. 

3. Enter your Existing Site Key, Product Registration 
Numbers and Customer Keys, then click “Next”. 

 

 
4. In the next screen, you will see a summary of the 

current license and a list of products that are 
available for you to add to the existing license. 
Check all the products that you would like to 
license. Copy the Site Code from the License 
Utility of the destination machine and paste it into 
the Site Code text box of the current web page, 
then click “Next”. 

 

 

http://www.iconics.com/supportworx
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5. Review the license information before proceeding. 
Select “Generate Key” as shown in the following 
image. 

 

 
 

6. The next screen will display the new Site Key and 
the link to your license file. Follow steps 13 to 18 
from 4.4.1.1 “Issuing a New Software License” to 
complete the licensing process. 
 

4.4.3 Upgrading a Software License Key 
There are four basic steps when it comes to upgrading a 
license via the Web Licensing Utility: 
 

• Step 1: Kill the older version license and credit it on 
our website 

• Step 2: Upgrade the license on our website 
• Step 3: Uninstall the older version of software and 

install the newer version 
• Step 4: License the newer version 

 
The order in which you do Step 2 and Step 3 does not 
matter.  
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4.4.3.1 Killing a License via the ICONICS Web Licensing Utility 
See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the Licensing Utility 
(Software License Activation for .NET) provided on the 
AnalytiX DVD. Be sure to take note of the Site Key and Kill 
Confirmation Code. This information is necessary to put the 
license back on the ICONICS website. NOTE: This 
information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 
 
Once you have the Kill Code, follow these additional steps: 
 

1. Go to http://www.iconics.com/supportworx and 
launch the Web Licensing Utility Site by clicking on 
the “License Product” link on the right side of the 
page. 

 

 
 
 
 
 
 
 
 
 
 

http://www.iconics.com/supportworx


ICONICS Software Licensing AnalytiX Getting Started 

 ICONICS 4-20 

2. The main page of the Web Licensing Utility will 
load. Click on the “Software” button to access the 
Software License Options. 

 

 
 

3. You will be required to log in to access the 
Software License Options. Enter your email 
address and password and click on the “LOGIN” 
button. If you do not yet have an account, you can 
create one by clicking on the “Create New 
Account” link near the bottom of the page. 
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4. Click on the “Kill License” link in the top navigation 
bar. 

5. Copy the Site Key from the KillCode*.TXT file into 
the Site Key field on the web page, then copy the 
Kill Confirmation Code into the Kill Code field on 
the web page. Next, click on the “Remove Key” 
button on the web page. 

 

 
 

6. You will get a message confirming that the Site 
Key has been successfully deleted as shown in 
the image below. The products associated with the 
deleted Site Key will now be available to be re-
licensed. 
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4.4.3.2 Upgrading the License on ICONICS Website 
See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the Licensing 
Utility (Software License Activation for .NET) provided on 
the AnalytiX DVD. Be sure to take note of the Site Key 
and Kill Confirmation Code. This information is necessary 
to put the license back on the ICONICS website. NOTE: 
This information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 

 
1. After you have copied your Site Key and Kill 

Confirmation Code in the previous step (either 
physically or electronically), you can now visit 
http://www.iconics.com/supportworx.  

 

 
 

2. Next, click on the “License Product” link. This 
opens a new Web page, as shown below. 

 

 

http://www.iconics.com/supportworx
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3. Click on the “Software” button to proceed. You will 
then be required to enter your email address and 
password for the site, as shown below. If you do 
not already have a login for this page, click on the 
“Create New Account” link near the bottom of the 
page. 

 

 
 

4. Once you have logged in, click on the “Kill 
License” link in the top navigation bar. 

5. Next, fill in your Site Key and Kill Code information 
that you copied while killing your previous license 
(see 4.2.4 “Killing a Software Key License”). 
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6. Once you kill the license on ICONICS’ website, 
you will receive an email containing the following 
information: 
• Site Key 
• Kill Code 
• Product for which you have killed the license 
 
The web page itself should now look similar to the 
figure below. 
 

 
 

7. At this point, you have completed killing the 
license. Notice that in the final “Kill License” page, 
as shown above, it states that if the license is 
eligible, it can be upgraded to the latest version 
and it provides a link for availability. 
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4.4.3.3 Checking License Upgrade Availability 
The easiest way to check if your license is available for an 
upgrade is by clicking the link on the page immediately after 
you kill the license. Clicking the link brings you to the 
Upgrade License page. You can also get to this page by 
clicking on the “Upgrade License” link in the tree control 
(third item). 
 
Follow these steps to upgrade your license. 
 

1. On the Upgrade License page, fill in your Product 
Registration Number and Customer Key. This is 
the same information you received in the web 
page and in your email after you have killed the 
license on our website. 

2. Click on “Next” when you have filled in the 
necessary information. 

3. If the license is available for an upgrade, you will 
see the available license on the page. 

 

 
 

4. Notice that the Product Description here shows a 
different product with an earlier version license 
(Version 8). Yours should reflect the license you 
have for your product. Check the available product 
that you would like to upgrade and click on “Next”. 

5. The next page is a confirmation page. Check that 
the information shown is correct and click on the 
“Upgrade” button to proceed. 
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6. On the new page that loads next, you can see a 
list of upgraded products. Notice that the Product 
Description shows a license for a later version 
product (Version 9.2) instead of the earlier one 
(Version 8). 

 

 
 

7. You should also receive an email with the license 
upgrade information. 

 

4.4.4 Upgrading a Hardware Key License 
Upgrading a hardware key license is similar to upgrading the 
software key license. You would follow the exact same 
procedure as upgrading a software license. In the case of a 
Hardware key License though, you will need the USB dongle 
in order to kill the license from it and put the new one onto 
the key. 
 

4.4.5 Licensing the New Version 
Now that you have upgraded the license, you can follow the 
regular procedure to license your machine with the new 
version. When it asks you for the Product Registration 
Number and the Customer Key, you can provide the same 
one. This information was sent to you in the last step of 
upgrading your license via email. If you need more 
information on how to license the machine with the upgraded 
license, please consult our application notes titled Licensing 
– Using the ICONICS Web License Utility for Software Key 
Licenses and Licensing – Using the ICONICS Web License 
Utility for Hardware Key Licenses, as it pertains to your 
individual situation. These Application Notes and more can 
be found via the Info Center on the AnalytiX DVD. 
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4.5 Cloud Licensing  
4.5.1 How Cloud Licensing Works 

ICONICS Cloud Licensing is a means of licensing ICONICS 
products that is specifically designed for applications running 
on public cloud, private cloud, or virtualized environments. 
Rather than maintaining the license locally on the machine, 
licenses are hosted by ICONICS on a publicly-accessible 
data center.  
 
During normal operations of the licensed machine, the first 
action it takes when starting up is to request the license 
information according to its License Pool ID. This request 
requires the machine to have access to the internet in order 
to request the information from the ICONICS cloud licensing 
server.  
 
Once the license information has been successfully 
retrieved, the machine continues to operate using the 
licensing information retrieved from the web. The machine 
then periodically checks with the ICONICS Cloud Licensing 
server in order to validate the license. If it cannot validate the 
license for an extended period of time, the machine license 
will fail.  

4.5.2 Issuing a New Cloud License  
Follow these instructions to activate a license on a machine 
that currently has no license on it, or has a license on it that 
you want to overwrite. 
 
If your machine already has a license on it and you are 
looking to add another license to it, see the next section 
entitled, “Adding to an Existing Cloud License”. 
1. Go to http://www.iconics.com/support and click the 

“License Your Product” link on the right.  
2. In the new page that appears, select “Cloud” and log in 

with your username and password.  
 
Note: If you do not have a username and password pair, you 
can register for one using the “Create New Account” link at 
the bottom of the window.  

http://www.iconics.com/support
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If you have a username and password but have forgotten 
them, you can click on the “Forgot Password” link at the 
bottom of the window. 
 
3. Once you have logged into the website, click on the 

“New License” link at the top. 
4. Enter your Product Registration Number(s) and 

Customer Key(s) for the products. 
 
Note: Your Product Registration Number(s) and Customer 
Key(s) are usually inside the DVD tin package that ICONICS 
sent when the product was purchased. 
 
5. Click the “Next” button once you have entered all of 

your Product Registration Number(s). 
6. Choose an existing end user or enter new end user 

information. Click “Next” when done. 
 
Note: The existing end user dialog may take a few moments 
to appear. Please be patient. 
 
7. On the next screen, you see a list of the products that 

are available for you to license. Check all the products 
that you would like to license on this machine. Click 
“Next”. 

8. This page shows you a summary of what is in your 
license. Check to make sure everything is correct, then 
click on the “Generate Key” button. A page similar to 
the image below appears. 
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4.5.3 Activating the License 
1. Open the “Platform Services Configuration” application 

by going to Start > Programs > ICONICS > Tools > 
Platform Services Configuration. 

2. Select the “License” tab. 
3. Select the radio button for “Cloud License” and enter 

the “License Pool” code that was provided by the Web 
License Utility. You can leave the “Password” blank. 

4. Restart the FrameWorX64 Service. 

4.5.4 Adding an Existing Cloud License 
1. Go to http://www.iconics.com/support and click the 

“License Product” link on the right. 
2. In the new page that appears, select Cloud and log in 

with your user name and password. 
3. Once you have logged into the website, click on the 

“Add to License” link at the top. 
 
Note: It is very important to pick “Add to License” and not 
“New License”. Picking “New License” overwrites any 
existing license already activated on this machine. Make 
sure to pick “Add to License” if you are adding products to a 
machine that already has a license on it. 
 
4. Enter your existing License Pool ID and the Product 

Registration Number(s), and Customer Key(s) for the 
new products. 

 
Note: Your Product Registration Number(s) and Customer 
Key(s) are usually inside the DVD tin package that ICONICS 
sent when the product was purchased. 
 
5. Click the “Next” button once you have entered all of 

your Product Registration Number(s). 
6. Choose an existing end user or enter new end user 

information.  
Click “Next” when done. 

 

http://www.iconics.com/support
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Note: The existing end user dialog may take a few moments 
to appear. Please be patient. 
 
7. In the next screen, you see a list of the products that 

are available for you to license. Check all the products 
that you would like to license on this machine.  
Click “Next”. 

8. This page shows you a summary of what is in your 
license. Check to make sure everything is correct, then 
click on the “Generate Key” button. 

4.5.5 Killing a Cloud License  
1. Go to http://www.iconics.com/support and click the 

“License Product” link on the right. Select the “License” 
tab. 

2. In the new page that comes up, select “Cloud” and log 
in with your username and password.  

3. Once you have logged into the website, click on the “Kill 
License” link at the top. A page similar to the figure 
below appears. 
 

 
 

4. Enter your License Pool ID into the prompt.  
Click “Remove Pool”. 

5. A message confirming that the license has been 
successfully removed appears. You will also receive an 
email with the killed license information. The products 
associated with this License Pool are now safely parked 
on the website and available to be re-licensed at any 
time. 

http://www.iconics.com/support


AnalytiX Getting Started ICONICS Software Licensing 

ICONICS 4-31 

4.6 Demo Mode 
Without a valid license installed in your PC, it is still possible 
to use AnalytiX in Runtime mode. The software will check for 
a valid hardware or software license key on initialization. If 
none is found, GENESIS64 runs in Demo Mode, which limits 
you to: 
• Twelve hours of runtime 
• Only 64 OPC tag connections (points) can be updated 
Running AnalytiX longer than the 12-hour limit generates a 
message stating that the demo time has been exceeded. 
You must then exit AnalytiX and reboot the PC. On restarting 
AnalytiX, you will get another 12-hour block of time in which 
to run.  If there are more than 64 tags on a particular screen, 
gray keys (or whatever is configured as the Point Failure 
character) will appear in place of the actual I/O data. 
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5 ANALYTIX QUICK START 
5.1 Introduction  

This chapter provides a brief overview of the following 
AnalytiX products and tools: 

• Workbench 
• Facility AnalytiX 
• CFSWorX 
• BI Server 
• BridgeWorX64 
• ReportWorX64 
• Quality AnalytiX 
• Additional tools and utilities 

Note: For complete information about any AnalytiX product, 
please refer to the Help documentation, which you can 
launch from the ICONICS product itself. 

5.2 Workbench 
The ICONICS Workbench is a multi-functional, centralized 
web-based environment is included as part of the Platform 
Services in the AnalytiX suite installation. 
 
The Workbench offers a light-weight deployment with a fast 
startup time, which also supports third-party plug-ins. The 
updated Workbench, including familiar elements such as a 
tool bar ribbon and Project Explorer, but with enhanced user 
friendly options such as a list-view Project Explorer for 
browsing which can be filtered and sorted. 
 
The Workbench runs in all browser platforms, including 
Microsoft Internet Explorer, Firefox, Chrome, Safari, and 
more.  
 
In the Workbench, you can: 

• Organize data sources on the basis of a 
hierarchical structure of assets and equipment, 
using AssetWorX. 

• Locate and react to Facility AnalytiX faults if the 
FDDWorX provider is installed. 
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Many configurations can be done from within the 
Workbench.  
 
To open the Workbench from the Windows Start button, 
select All Programs > ICONICS > Workbench. 
 
When you open the Workbench for the first time, you will be 
able to see all of the applications, tools, utilities and services 
listed in the Project Explorer that you can open within the 
Workbench. 

 
It is made up of: 

• The Ribbon bar (along the top). 
• Two Project Explorers that you can hide or show: 

o A tree explorer that gives you a way to 
navigate and browse; and buttons that give 
you access to ICONICS providers. 

o A grid explorer you can use for searching. 
• The content or work area where configuration 

forms open. 
 
Ribbon: 
The ribbon for the Workbench is designed to help you 
quickly find the commands you need to complete a task. 
Commands are organized into logical groups. 
 
The Home tab provides general tool bar functions and 
changes depending on the item that is selected in the 
Project Manager. In addition, ProjectWorX allows you to 
utilize new features for your database. Examples are shown 
below. 

  
You can minimize the ribbon by double-clicking on the ribbon 
tabs. 

  
Development and runtime modes of all installed and licensed 
ICONICS (AnalytiX and GENESIS64) products can be 
accessed and used in the Workbench.  
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Even though all of the providers are available in the 
Workbench, you can pick and choose which providers 
appear in the Workbench's Project Explorer. 

5.3 Facility AnalytiX/FDDWorX 
Facility AnalytiX is a predictive building automation solution 
powered by ICONICS’ powerful FDDWorX engine with 
advanced Fault Detection and Diagnostics (FDD) technology 
at its core to detect and predict faults in equipment. It 
incorporates algorithms that weigh the probability of faults 
and advises management, operators and maintenance 
personnel of actions to prevent equipment failures or 
excessive use of energy. With Web-based configuration, 
Facility AnalytiX is easy to setup and deploy, integrating with 
most popular BAS, SCADA and building systems. An 
extensive library of standard equipment diagnostic models 
speed setup and configuration, while a rules based editor 
lets you easily customize and add new equipment 
diagnostics models. 
 
When equipment failures occur, advanced software 
technology provides automatic guidance to a list of causes 
sorted by probability, resulting in reduced downtime and 
lower costs to diagnose and repair.  
 
Information obtained from Facility AnalytiX can be used to: 
 

• Predict, reduce, and eliminate equipment 
downtime 

• Automate fault detection and real-time notifications 
• Reduce maintenance and determine probable 

causes 
• Improve reliability and control 
• Improve overall environmental quality 

 
To launch Facility AnalytiX, from the Windows Start menu, 
select All Programs > ICONICS > Workbench. Then, 
select the Facility AnalytiX provider within the Project 
Explorer on the left. 
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5.4 CFSWorX 
ICONICS CFSWorX is a Connected Field Services solution 
containing a set of digital tools that provide: 

• Realtime Monitoring of Field Equipment 
• Realtime Monitoring of Service Worker Availability 

and Location 
• Alerts to Field Workers when Field Equipment 

Requires Service  
o Equipment status alerts (alarms) 

available to all Field Workers 
o Can auto-notify Field Worker(s) of Field 

Equipment Failures 
o Can Choose the Most Appropriate or 

Closest Service Worker 
o Monitors Responses from Notified 

Service Workers 
o May Notify Backup Worker(s) in case 

Primary is Not Available 
• A Maintained Audit Trail of Notifications and 

Activity 
 
CFSWorX is comprised of multiple entities including:  

• Monitoring (of both Field Equipment and Field 
Workers) 

• Workflows 
• Alerting (via Notifications) 
• Mobile App  
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5.4.1 Monitoring - Field Equipment 
The monitoring of Field Equipment involves a backend of 
data source connectivity options (CFSWorX can work with 
any Platform Services real-time data source [e.g., 
OPC UA, Modbus, SNMP, etc.) and a robust Monitoring 
Engine (using AlarmWorX64 Server, Platform Services and 
AnyGlass Engine technology). The front end involves Alarms 
(exposed as A&E Events), and the mobile client (providing 
an alarm viewer for alarm details, alarm acknowledgment, 
and availability response options). 
 

5.4.2 Monitoring - Field Worker Availability 
CFSWorX is able to maintain a database of an organization's 
field workers. Users also have the option of syncing the 
database with third-party identity databases such as Active 
Directory or CRM. Users can also decide whether to sync 
external data or use local definitions - using information such 
as contact info (name, email, cell number for SMS, etc.) or 
CRM calendar. In addition, CFSWorX can associate 
ICONICS solution-provided data such as schedules (if not 
external), alarms, assets, mobile device health data 
(updated periodically), security ID, and groups. 
 
CFSWorX also includes Field Worker Mobile Health 
Monitoring. This includes Signal Strength, Battery Life, and 
Location (GPS). 
 

5.4.3 Workflows 
CFSWorX utilizes a new customizable Workflow Engine, 
based on existing ICONICS Workflow components. 
CFSWorX' Workflow engine provides the ability to both 
receive and consume alarms. It also supports additional 
states (including Rejected, Busy, and Accepted) via 
association between alarms and users. Generated alarms 
can be logged by ICONICS' alarm logger component, can be 
viewable by alarm viewer, and can be optionally send 
via SMS or Email Alerts. 
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CFSWorX' Worfklow will introduce new transaction execution 
options, including Alarm Source. It will also introduce new 
Blocks, similar to those used within ICONICS Bridging 
and standalone Workflow components. These include: 

• Alarm Event Output 
• Conditions Common: 

o Ack 
o Alarm 
o Normal 

• Conditions CFS: 
o Fixed Contact List 
o Worker Lookup 
o Accept 
o Busy 
o Reject 
o Assign 

• Communication Channel Send 
o SMS 
o ATT 
o Twilio SMS 
o Twilio WhatsApp 
o Others (future) 

 
Note that the following Workflow Blocks are not available for 
use with CFSWorX: 

• CSV File Reader 
• XML File Reader 
• CSV File Output 
• XML File Output 
• Data Set Reader 
• Historical Input 
• Historical Alarms Input 



AnalytiX Quick Start AnalytiX Getting Started 

 ICONICS 5-38 

• Bulk Real Time Input 
• Bulk Real Time Output 
• Bulk Data Manipulator 
• Data Manipulator 
• Data Set Transformer 

 

5.4.4 Notifications 
CFSWorX' Alert Engine architecture users a REST API to 
work with third-party services. It supports SMS 
acknowledgements, as well as alarms. It also log activity to 
an audit log. The pluggable architecture supports continued 
enhancements. 
 
Users are able to configure both reliable and "best effort" 
Device Notifications. The reliable notifications utilize 
ICONICS' FrameWorX to FrameWorX Mobile technology 
to transmit alarms. This channel supports Error Notification 
as well as Retry. The "best effort" notifications involve SMTP 
(email) and SMS (text messaging) technologies. That being 
understood, data sent in this manner cannot be guaranteed. 
These efforts are used only to notify users to launch a native 
application. Communications may go through a service 
provider such as ATT, Twilio, etc. 
 

5.4.5 CFSWorX Mobile App 
The CFSWorX MobileApp is based on ICONICS' MobileHMI 
technology and is able to be run on iOS and Android 
devices. It has the ability to collect and report mobile device 
health. It displays alarms in a MobileHMI Alarm Flip View. 
The mobile app supports new CFS worker response options, 
including Accept, Busy, and Reject. The displays (including 
operator/dispatcher dashboards) are customizable. 
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5.5 BI Server 
The landscape of data in today’s applications is of very 
diverse nature: systems are made of a large variety of 
components, many of which have their own data storage 
and their own interface to provide access to stored data – 
whether it is a web service,a database, an historian, etc. 
 
This scattering of information often makes it difficult to 
provide a cohesive view of a system and, even in cases 
where all the data can be visualized together, it might not be 
shaped logically for the end user. Correlating these different 
datasets with each other is challenging and trying to query 
them using a common set of filters or parameters is difficult. 
 
AnalytiX-BI was created to address these problems. Data is 
organized in user-defined Data Models, representing 
collections of datasets that are logically related to each 
other, irrespective of their physical origin. Data Models are 
connection to actual data using Data Flows; ETL processes 
that allow multi-step transformations of the ingested data for 
better shaping and filtering before loading it in a model. 
 

5.5.1 AnalytiX-BI Overview 
There are many ways to use AnalytiX-BI, but the diagram 
below outlines the most common and most powerful 
architecture, and the way the pieces are designed to work 
together. 
 
Following the data from the bottom up, your originating data 
sources can be just about any piece of data that ICONICS 
can connect to, whether it be OPC, web services, Hyper 
Historian, AssetWorX, or a custom database. This data is 
pulled into data flows. Each data flow is a sequence of steps 
to modify and shape the data to best fit the data model. Data 
flows can be parameterized, so clients can get only the 
specific data they need. 
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Note: Data flows are not cached. Each time a data flow is 
accessed, the data is read from the data sources anew and 
all steps are followed. 
 
Once the data has been shaped by data flows, it is pulled 
into data tables inside a data model. The data model defines 
relationships between the tables. These relationships make 
it easy to query the data. Data models cache the data, and 
use a number of techniques to optimize memory use and 
performance. (See Performance Considerations.) 
 
Data from a data model can either be queried directly by 
clients such as GraphWorX64 or KPIWorX, or the user can 
predefine views for a data model. Views can be based 
on the data tables, or on other views. Due to the predefined 
relationships, it is very easy to query the data model without 
having to worry about the proper JOINs between tables. 
 
Since the data model is cached, triggers can be defined on 
each data table in the model to re-query its data source. 
Triggers can tell the table to be dropped and recreated 
anew, or only update the records that have changed. Each 
table can have multiple triggers, so you can define the best 
scheme to ensure your table is refreshed in the manner best 
suited for it. Triggers can work with parameters of data flows 
to only pull in data since the last data model refresh. 
 
This architecture takes full advantage of all the features of 
AnalytiX-BI, but it is flexible, and many of its parts are 
optional. If there is no need to shape or parameterize your 
data, you can pull a data source directly into a table inside a 
data model without using a data flow. You can connect your 
clients directly to data flows without a data model if you only 
need to do some shaping and have no need to cache the 
data. You can forego views, and simply connect your clients 
directly to the model, writing your query within a point name. 
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5.6 BridgeWorX64 
The Bridging provider in the Workbench, based on ICONICS' 
BridgeWorX technology, provides Graphical Data Bridging, 
taking advantage of multi-core, 64-bit systems as well as 
utilizing .NET 4.6 and the Parallel Tasks Library.  
 
It also fully integrates with ICONICS V10 Platform Services, 
including: 

• Common Workflow Execution Engine 
• Data Flow Library 
• GridWorX 
• Web Services 
• BI Server 
• OData (REST) 
• Facility AnalytiX, AlertWorX, ReportWorX, etc. 

 
The Bridging provider in the Workbench provides multiple 
user benefits, including: 

• Transaction Workflow Execution 
• Transaction Triggering 
• Enterprise Service Design 
• Transaction Recovery Option 

 

5.6.1 Transaction Workflow Execution 
Transaction Workflow Execution includes: 

• Diagram Designer - providing custom control flow 
logic 

• Drag & Drop configuration of Transaction Diagram 
Activities 

• Connectivity to heterogenous data sources 
• On Complete, On Success, On Fail, On True, On 

False control flow branching 
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• Ability to execute custom .NET code in a 
Transaction 

 

5.6.2 Transaction Triggering 
Transaction Triggering provide the following trigger types: 
Manual 
Periodic 
On OPC Data Value Change 
On Alarm 
On Database Value Change 
On File/Directory Change 
On NT Event posted 
 

5.6.3 Enterprise Service Design 
Enterprise Service Design provides: 

• Multithread/multicor design with Parallel Task 
Library 

• Concurrent Transaction execution on a Thread 
Pool 

• Workflow Priorities: Normal, Below Normal, Above 
Normal 

• If the Workflow Engine is already running at 
maximum capacity, then other submitted 
workflows are enqueued in the Priority Queue. 

• Powerful transaction options for enqueuing 
transactions: 

o Queue and Execute immediately 
o Queue and Execute if no other similar 

transaction is running 
o Queue and Execute if no other similar 

transaction is running or enqueued 
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5.6.4 Transaction Recovery Option 
The Transaction Recovery Option provides: 

• Heartbeat of running Transaction 
• Recovery Options 

o No Recovery 
o Re-Execute from Start 

 

5.6.5 Transaction Data Sources 
All transaction data sources will come from the BridgeWorX 
DataFlow engine. Real 'live' data sources (i.e., those driven 
by subscription-based callbacks) are converted into datasets 
at the moment of consumption. 
 
Single values (e.g., OPC DA, BACnet, SNMP, etc.) are 
represented as a simple data set containing at least a value, 
quality and timestamp. However, they may include any 
additional properties requested by the user (e.g., 
engineering units, high/low range, etc.). 
 
Current alarms (e.g. OPC A&E, BACnet, custom point 
managers, etc.) are transformed into a dataset (table) when 
activity executes (like a snapshot of a "current" active 
alarms pattern). 
 
Data sources that are not subscription-based, but require 
polling, will make use of reader blocks to control exactly 
when the Read is executed, including: 

• Datasets (e.g., Web Services, Database Queries, 
custom point managers) 

• Historical Data (e.g., OPC HDA, BACnet, custom 
point managers, etc.) are transformed into a 
dataset (table) 

• CSV files 
• XML files 
• JSON files 
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5.6.6 Transaction Activities 
Transaction Blocks (activities) are used to manipulate the 
data. Internally, they handle data as in-memory datasets. 
 
All Reader Activities will have at least one output dataset. 
 
The Expression Syntax allows users to use any Activities 
output value of row X, columnY in expression calculations. 
 

5.6.7 Variables 
Global and Local Variables in Bridging in the Workbench are 
typed DataSets. Schema defines column names and column 
data types. Global Variables are exposed by BridgeWorX64 
Point Manager as DataSets. 
 
Elements of Global, Local, Trigger Variables or Parameters 
could be used as data sources or in expression calculations. 
 

5.6.8 Configuration 
Bridging configuration is easy to use and maximizes 
available space within the Workbench tool. It is possible to 
use Drag & Drop within transactions. Each activity has an 
intuitive configuration tool, with no popups. A handy library of 
activities is available, as well as visual feedback about any 
errors within diagrams. 
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5.7 ReportWorX64 
A new data reporting ability has been added to GENESIS64 
via a new provider within the Workbench. Reports are 
integrated in the system, similar to how alarms or historical 
data are treated. 
 
Reports in the Workbench in GENESIS64 contains multiple 
features, including: 
 

5.7.1 Report Dashboard 
 
Data Integration 

• Uses simple drag-and-drop interfaces to create 
flexible, interactive data visualizations 

• Integrates with the AnalytiX BI Server 
• Contains drill-down capabilities 
• Can share data to any device 
• Uses Responsive Design - for access on any 

device any time in any location 
 

5.7.2 Report Server 
• Supports features of ICONICS ReportWorX32 32-

bit-based reporting product 
• Integrates with ICONICS FrameWorX Server 

o Data can be consumed by any client 
o Utilizes unified security and licensing 
o Does not require Microsoft Excel to be 

installed on the server 
o Uses standard OpenXML SDK to 

manipulate reports 
o Each report exposes a list of tags that 

can be browsed 
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5.7.3 Report Sources 
• Data sources are unified for a complete view of 

information 
• Utilizes a Data Flow Library 

 

5.7.4 Report Generation 
Reports can be scheduled at specific times or under specific 
conditions. Actions (Workflows, Schedules, Triggers) can be 
used to execute reports. 
 
Reports can also be manually generated. A Report Control 
Page can be utilized on any glass, similar to ICONICS 
Health Monitoring System. 
 

5.7.5 Report Execution 
Report Execution is performed when the server retrieves the 
template from the configuration. The OpenXML SDK is used 
to generate the reports. (Note that Microsoft Excel is not 
required on the server side.) The generated report is saved 
in a runtime database, which is not tied to the configuration 
database. 
 
Users can use the system to deliver customized reports 
anywhere automatically. In addition, generic commands can 
be executed when reports are successful, are failing 
or simply when completed. 
 
ICONICS' commanding abilities have been enhanced to 
support the ability to attach reports. For example, a "Send 
Email" command could forward a report to AlertWorX. 
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5.8 Quality AnalytIX 
Quality AnalytiX is part of the AnalytiX product suite for 
GENESIS64. With Quality AnalytiX, you can monitor the 
efficiency and reliability of any system using statistical 
methods. These tools allow you to detect and correct for 
anomalies in your industrial process more easily than ever 
before. 
 
This component of the AnalytiX suite allows you to access 
and configure SPC tags, distribution rules, and statistical 
calculations in Hyper Historian. You can also create and 
view trends and alarms associated with SPC tags and 
calculated tags within TrendWorX64 or AlarmWorX64.  
 
Quality AnalytiX also supports: 

• New chart types in TrendWorX64 (Histogram and SPC)  
• Integration with ReportWorX Express  
• Dashboard customization in PortalWorX 

Quality AnalytiX delivers charts, KPIs, data, and alerts to any 
device, any time. It also provides an extensive set of viewing 
options to create dazzling displays and dashboards for your 
device. These views allow you to monitor your processes, 
identify issues, and fix them in a proactive manner to 
achieve better performance for your system. 
 

5.9 Additional Tools and Utilities 
There are additional tools and utilities that are installed with 
AnalytiX. A brief description of each is described in the 
remainder of this chapter. For more information about a tool or 
feature, refer to the Help documentation included with the 
product. 

5.9.1 License Utility  
License Utility (Start > All Programs > ICONICS Licensing 
> ICONICS .NET Licensing > License Utility) provides full 
authorization for use of any purchased AnalytiX product and 
its available options.  
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MonitorWorX Viewer (Start > All Programs > ICONICS 
Licensing > ICONICS .NET Licensing > MonitorWorX 
Viewer) allows users to review the status of ICONICS 
licenses.  

5.9.2 Configure AnalytiX  
Configure AnalytiX (Start > All Programs > ICONICS > 
AnalytiX > Configure AnalytiX) allows you to configure the 
product similar to the options you were provided during 
installation. See Step 8 onward of “Starting the Install / To 
Install AnalytiX” on page 3-5 for detailed steps. 

5.9.3 SQL Server Setup  
SQL Server Setup (Start > All Programs > ICONICS > Tools 
> SQL Server Setup) allows you to select the SQL Server(s) 
that will be used by the ICONICS applications. The added 
SQL Servers will then appear in the Workbench to assist in 
the creation of, or connection to, databases. 

5.9.4 TraceWorX  
TraceWorX (Start > All Programs > ICONICS > Tools > 
TraceWorX) provides online diagnostics and tuning of 
ICONICS applications. TraceWorX is intended for use by 
systems integrators, OEMs and customers who want to have 
tools for doing their own troubleshooting and diagnostics. 
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6 HELP AND TECHNICAL SUPPORT 
6.1 Help Documentation 

ICONICS software provides online help with descriptions 
and explanations of each application. Help is available 
throughout ICONICS Suite. You can access help in the 
following ways: 

• Click the Help  icon in the Workbench. This opens 
the help file for that application. To search for a topic in 
the help file, click the Index tab or the Search tab. 
Type or select the term you want to find, and then click 
the topic you want to read. 

• Press the F1 key to display context-sensitive help. 
• Click the Help button in any dialog box to display 

context-sensitive help for that dialog box. 
• Move the mouse pointer over an icon and pause for a 

moment to display pop-up ToolTips for quick help. 
• From the Windows Start menu, select All Programs > 

ICONICS Help > Help. 

6.2 Product Videos 
A new feature of the Customer Connection Portal is the in-
depth training videos highlighting many ICONICS products. 
These videos help users configure their systems using the 
best practices. Starting with a Quick Start series introducing 
each module in GENESIS64, these videos provide brief 
overviews and demonstrations of how to use ICONICS 
products. We accept customer suggestions for 
improvements. 

6.3 Training Classes 
Training classes are held regularly at the ICONICS training 
facility in Foxborough, Massachusetts. To reserve seats in 
training courses and to view the current ICONICS training 
schedule, go to http://www.iconics.com/Training.aspx. If you 
have any questions about ICONICS training, please contact 
our training coordinator at 508-543-8600. 

http://www.iconics.com/Training.aspx
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6.4 Technical Support 
ICONICS customers may obtain technical support in several 
different ways. First-line Support is reached through your 
local ICONICS representative or distributor. You may also 
contact ICONICS’ Support Engineers directly by phone, 
email or the Customer Connection Portal 
(https://getconnected.iconics.com).  
For complete information about Global Technical Support, 
please see the Global Support and Services User Guide at 
http://www.iconics.com/supportworx.  

6.4.1 Global Support and Services 
ICONICS is proud to provide our customers with the highest 
quality customer service. Our Global Support and Services 
programs are supported by ICONICS offices around the 
globe and our network of sales channel distributors and 
representatives, with local and regional locations for front-
line service and expert assistance. Programs include the 
SupportWorX™ Technical Support Services subscription 
program for continuous technical support; Quality 
Professional Services for expert system architecture 
design assistance, training and start-up assistance; a 24 x 7 
Emergency Support Option plan; and Training and 
Certification programs for ICONICS users, systems 
integrators and sales channels.  
For complete information about SupportWorX service plans 
and technical support, please see the Global Support and 
Services User Guide at: 
http://www.iconics.com/supportworx. 

6.4.2 Customer Connection Portal 
Get connected with ICONICS by visiting the Customer 
Connection Portal for general support, product downloads, 
product updates, customer collaboration and product tips 
from ICONICS’ engineers and support team. The Customer 
Connection Portal features Support Solutions, a Support 
Bulletin, product videos, app notes, and whitepapers. The 
Support Solutions section addresses essential questions 
through the FAQ, Licensing, and a Global Search Engine, 
enabling users to find answers quickly and easily. The 
Support Bulletin lists your support cases with real-time status 

https://getconnected.iconics.com/
http://www.iconics.com/supportworx
http://www.iconics.com/supportworx
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updates along with popular knowledgebase articles and the 
most active forum threads. If users are current on their 
SupportWorX software maintenance plan, they are entitled 
to free upgrades. Download the latest product updates and 
new product releases from the Customer Connection Portal 
or sign up for the Beta program to try select features before 
they are officially released 

6.4.3 Telephone Support 
ICONICS support centers are open Monday through Friday, 
year round, except for local holidays and ICONICS holidays.  
Support handles calls on a first-come, first-served basis 
during the business hours below. 

Americas (United States):  
1-508-543-8600 

8:00 AM – 6:00 PM 
Eastern Standard Time 

Europe (Czech Republic):   
+ 420-377-183-420 

9:00 AM – 5:00 PM  
European Central Time 

Asia Pacific (Australia):  
+ 61-2-9605 1333 

9:00 AM – 5:00 PM  
Australian Eastern Time 

Please have the following available when you call: 
• Your SupportWorX Plan Number. 
• A PC available for tests and diagnostics. 
• A clear understanding about the issue. 
• The version of your OS and the ICONICS product(s). 
• OPC server or relevant third-party software info. 
Note: Go to 
https://getconnected.iconics.com/ICONICS/Support/GetSupp
ort.aspx to contact our Technical Support department.  

 
Email Support 
The ICONICS support center email addresses are: 
• North America: Support@ICONICS.com 
• Europe: EuropeSupport@ICONICS.com 
• Pacific Rim: PacificRimSupport@ICONICS.com 

https://getconnected.iconics.com/ICONICS/Support/GetSupport.aspx
https://getconnected.iconics.com/ICONICS/Support/GetSupport.aspx
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Please include your SupportWorX Plan Number when 
sending your message. Email requests will be answered on 
a first-come, first-served basis typically the same day. 
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NOTES
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To open a support case, please visit 
our Customer Connection Portal at 
getconnected.iconics.com.

For more, visit www.iconics.com
© 2019 ICONICS, Inc. All rights reserved. Specifications are subject to change 
without notice. AnalytiX and its respective modules are registered trademarks 
of ICONICS, Inc. GENESIS64, GENESIS32, Hyper Historian, BizViz, PortalWorX, 
MobileHMI and their respective modules, OPC-to-the-Core, and Visualize Your 
Enterprise are trademarks of ICONICS, Inc. Other product and company names 
mentioned herein may be trademarks of their respective owners. 
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